Table of Contents

1 Introduction to SQR ......................................................................................................................... 1
   • 1.1 Welcome to ALIS SQR ............................................................................................................... 1
   • 1.2 ALIS User Roles ..................................................................................................................... 1
   • 1.3 Content of the document ....................................................................................................... 1

2 Navigating the Interface .................................................................................................................... 2
   • 2.1 Log on to the system through NY.gov ................................................................................... 2
   • 2.2 Navigate the Map .................................................................................................................... 6
   • 2.3 Use the GoTo Functions to Navigate the Map ...................................................................... 10
   • 2.4 Add the Table of Contents to the Map and Add a Layer ....................................................... 14

3 Using the Draw tools ....................................................................................................................... 18
   • 3.1 Draw tab ................................................................................................................................. 18
   • 3.2 Feature Selection tab ............................................................................................................. 20

4 Creating a Simple Query .................................................................................................................. 22
   • 4.1 Enter/Remove Case ............................................................................................................... 22
   • 4.2 Create a Simple Query .......................................................................................................... 22
   • 4.3 Add the study area ................................................................................................................. 23
   • 4.4 Save the Query ..................................................................................................................... 24
   • 4.5 Print the map ......................................................................................................................... 25

5 Query Management ......................................................................................................................... 26
   • 5.1 Check the status of a scheduled query .................................................................................. 27
   • 5.2 Load the results of an existing query ..................................................................................... 28

6 Creating Reports ............................................................................................................................... 30
   • 6.1 Select cases and remove cases ............................................................................................ 30
   • 6.2 Filter results .......................................................................................................................... 31
   • 6.3 Create and manipulate CSV output files .............................................................................. 32
   • 6.4 Create reports ..................................................................................................................... 34
   • 6.5 Create statistical reports ..................................................................................................... 37

7 Appendices ......................................................................................................................................... 41
Introduction
In this lesson, you will learn how to navigate the ALIS interface. The ALIS interface is similar to that of several other online mapping applications.

Learning Objectives
After completing this lesson, you will be able to:
- Understand what SQR is
- Learn the ALIS user roles
- Determine how this document is organized
1.1 Welcome to ALIS SQR

The New York State Department of Transportation (NYSDOT) Simple Query, Reporting application (SQR) is a web-based application that provides a detailed map and data interface for accessing crash data. SQR is one of three applications in the New York State Accident Location Information system Suite (ALIS)

SQR leverages the location coded accidents that have been processed by the Department of Motor Vehicles using the Location Coding Data Entry Module (LCDE) of ALIS. Traffic Engineers from NYSDOT as well as regional and local governments can use SQR to conduct simple data extracts or detailed accident studies and reports identifying high accident locations and unusual concentrations of specific types of accidents.

SQR is designed and tested to support Microsoft Internet Explorer version 8. The application is designed to run under a screen resolution of 1280 by 1024 and normal DPI settings which are equal to 96 dpi. It is important to set the screen resolution of your monitor to these specifications to ensure correct display of the various components.

1.2 ALIS User Roles

Depending on the functionality utilized by the user, LESQR differentiates between three Users or Roles:

- **SQR User** – A DOT staff member who is responsible for generating simple geographic queries and producing both tabular and graphical reports.
- **LE User** - A DOT staff member who resolves unknown or incorrect accident locations following their entry into the LCDE module.
- **LE/SQR User** - A DOT staff member who is authorized to both query data in order to produce reports and recode accident locations.

1.3 Content of the document

This manual is designed to provide the end user with the information necessary to use this application. The instructions are presented in the order of a typical workflow. The content has been organized so that each section follows the other in a logical way.
Chapter 2
Navigating the Interface

Introduction
In this lesson, you will learn how to navigate the ALIS interface. The ALIS interface is similar to that of several other mapping applications.

Learning Objectives
After completing this lesson, you will be able to:
- Log on to ALIS using NY.gov
- Use mapping functions (zoom, pan, etc.)
- Use the GoTo functions to navigate
- Add a layer to the map
2.1 Log on to ALIS using NY.gov

1. Type in the address, [https://my.ny.gov/](https://my.ny.gov/) in Internet Explorer.

2. Click the Sign In button in the center of the page if you were issued a Username and Password.

To request access to one of the ALIS applications, contact Andrew Sattinger at [Andrew.Sattinger@dot.ny.gov](mailto:Andrew.Sattinger@dot.ny.gov) or 518-457-9736.
3. Type in the **Username** and **Password** you were issued and click the **Sign In** button or press the enter key.

![NY.gov ID Login](https://ny.gov/gov.png)

**Please note**: In order for NYSDOT to provide assistance in the most efficient and cost-effective manner, we ask that you DO NOT request password resets from the OITS Enterprise Help Desk, as that transaction will result in a fee.

**If your New York State Directory Service (NYSDS) account was set up by NYSDOT**, contact Andrew Sattinger at Andrew.Sattinger@dot.ny.gov or 518-457-9736 for a password reset. If Andrew is not available, contact Robert Morgan at Robert.Morgan@dot.ny.gov or 518-457-9191.

**If your NYSDS account was not set up through NYSDOT**, please contact your organization's Delegated Administrator. The Delegated Administrator is the person in charge of creating and managing your organization's LDAP/NYSDS accounts.
4. If the log on is successful, the **My NY.gov Online Services** page is displayed. It lists the applications you have access to. Click the **ALIS** button.
Click on the **I Agree** button to work in ALIS.

For LESQR/QRA Application Issues, Error Messages, or Other Questions, first contact Andrew Sattinger at Andrew.Sattinger@dot.ny.gov or 518-457-9736. If Andrew is not available, contact Barbara Mullin at Barbara.Mullin@dot.ny.gov or 518-485-2705
2.2 Using Mapping Functions

If you have used Google Maps or Bing Maps, navigating this map should be very similar.

1. Identify Features
   - Click the **Identify Features** button.
   - The **Identify Results** window appears. In the drop down box, choose a layer you wish to identify.
   - Click in the map on one of the features of that layer.
• The **Identify Results** window will populate with information about that feature. The below screenshot illustrates an **Identify Features** command done on a bridge.

![Identify Results Window](image1)

2. **Measure Tool**

• Click **Measure**.
• The **Measure** dialog box appears. There are a few options:
  o **Measure Length** – measures the straight line distance between two points
  o **Measure Area** – measures the perimeter and area of a polygon
  o **Check Coordinates** – returns the (x, y) coordinates of a selected point
• A screenshot is shown below.

  ![Measure Dialog Box](image2)

  **NOTE:** For the **Measure Length** and **Measure Area** commands, there are options to display different units of measure and also to draw diagrams freehand.
3. **Map Views** – there are three possible map views: Streets, Topo, and Imagery.

4. **Pan tool**
   - To *pan* is to move in the map. Panning can be done in one of two ways
     - Moving the mouse – click and drag the mouse from one end of the screen to the other to pan.
     - Using the compass – click the top arrow to move north, the left arrow to move west, the right arrow to move east, and the bottom arrow to move south

5. **Zoom to Full Extent**
   This button allows you to see the full extent, which is the default jurisdiction, explained below.

6. **Click to zoom to default jurisdiction**
   The default jurisdiction depends on the role assigned to the user.
     - If the user is an administrator, the default jurisdiction is the entire state.
     - If the user is a county, then the default jurisdiction is the entire county.
     - If the user is an MPO, then the default jurisdiction is the MPO boundary.

7. **Zoom Tools**
   Zooming in can be done one of several ways

   **Mouse** - Use the scroll wheel
   - Zoom in = move scroll wheel counterclockwise.
   - Zoom out = move scroll wheel clockwise.

   In the map – On the left hand side of the screen, click the plus arrow to zoom in and the minus arrow to zoom out.

8. **Bing Birdseye View**
   - Zoom in closely to your study area location.
   - Click the button labeled, **Click to activate Birdseye view tool**
Click once on the appropriate location on the map.

A dialog box labeled **Birdseye View** will appear in the location clicked on.

**NOTE:** You will receive an error message if the location you click on does not have Bird’s eye images available.

---

9. **Google Street View**

- Zoom into the appropriate location.

- Click the button labeled, **Click to activate Google Street View tool.**
- Click once on the appropriate location on the map.
- A dialog box labeled **Street View** will appear in the location clicked on.
2.3 Use the GoTo Functions to Navigate

The GoTo functions are the third button on the leftmost toolbar.

The GoTo dialog box has three tabs:
1. **Address** – to navigate to a particular address, or a set of coordinates
2. **Reference marker** – to navigate to a particular reference marker
3. **County/Muni/Street** – to navigate to a particular county/muni/street

We will go through the tabs one by one.

**1A. Navigate to an address**

- On the **Address** tab, on the radio button labeled **Locate By**, click **Address**.
- Enter the address you desire in the format displayed in red.
- Click **Locate**.
- The nearest match to your entry will appear. Click on the best match.
- The map will zoom into your address.
1B. Navigate to coordinates

- On the **Address** tab, on the radio button labeled **Locate By**, click **Coordinates**.
- Enter the coordinates you desire.
- Click **Locate**.
- The address that matches the coordinates will appear. Click on the address.

![GoTo Screen](image)

- The map will zoom into your address.

2. Navigate to reference marker

- On the **Reference Marker** tab, in the text box labeled **Ref Marker**, enter the reference marker you desire.
- Click **Go**.

![GoTo Screen](image)

- A flashing purple dot will appear to represent the location of your reference marker.
3. **Navigate to county/muni/street**

To zoom into a particular county, use the drop down labeled **County** to select the desired county. Then, click **Go** next to the drop down for **County**. ALIS will zoom into the county.

To zoom into a particular municipality, select the desired county. Next, use the drop down labeled **Muni** to select the desired municipality. Then, click **Go** next to the drop down for **Muni**. ALIS will zoom into the municipality.

![Diagram showing how to navigate to county/muni/street](image-url)
To zoom into a particular street, select the desired county and the desired municipality. Finally, use the textbox labeled **Street** to enter the street name. If the street name matches a street name in the database, ALIS will zoom into the street and flash the street in purple.
2.4 Add a Layer to the Map

1. Click on the Table of Contents button on the right hand side of the screen.
2. The Table of Contents window will appear. There are several items in the Table of Contents. These items are referred to as layers.

3. To add a layer to your map, check the checkbox next to the layer name. To remove a layer from your map, uncheck the checkbox next to the layer name.

4. Transportation, Specialty PIL, and Priority Investigation Location are group layers. This means that they are a container for additional layers. If you click the triangle next to the Transportation layer, additional layers will appear: Bridge, Customs, Railroad, Reference Marker, Thruway, Streets.

NOTE: Under the Transportation group layer, the Bridge, Customs, Railroad, and Reference Marker layers appear greyer than the Thruway and Streets layers. The reason is that there are scale dependencies in the layers. This means that certain layers cannot be displayed at certain scales. To view these layers, zoom in to the map until the layer name is no longer greyed out, and then check the checkbox next to the layer.
5. Zoomed in to the project level, all of the Transportation layers can be added to the map by checking the checkboxes next to their names.

6. Click the triangle next to each of the layers in the Transportation group layer. You will see certain graphics. These graphics are referred to as symbology.
7. In the map below, you can identify a bridge and several reference markers by the *symbology*. For example, the reference markers are represented in the map by a green flag.

8. When you no longer need the **Table of Contents**, click on the “x” in the top right corner of the **Table of Contents** window.
Chapter 3
Using the Draw tools

Introduction
In this lesson, you will learn how to use the draw tools in ALIS. The draw tools are typically used to draw a study area for a query.

Learning Objectives
After completing this lesson, you will be able to:
- Select a study area using the tools in the Draw tab.
- Select a study area using the tools in the Feature Selection tab.
The Draw tools are in the top right hand corner of the screen. There are three tabs in the Draw tools toolbar: **Feature Selection**, **Build Path**, and **Draw**. You will not be using the **Build Path** tool in your ALIS SQR role.

3.1 **Draw tab.**

Selecting a study area is one of the first tasks that is performed when producing a query. There are two options: **Add from map selection**, **Select from boundaries**. The below steps will help you with the first option: **Add from map selection**.

**Study Area**

- **Add from map selection**
- **Select from boundaries**

Use the map toolbars to construct a study area polygon.

- **Append Selected Polygon on the Map to Study Area**
- **Delete Study Area**
- **Zoom to Study Area**
The **Draw** tools are used for this task. The **Draw** tools are shown below:

Draw a polygon using the following directions:

- Click on the **Draw polygon tool**.
- Click at the location where you would like the first side to begin.
- Drag the mouse where you would like the first side to end. Click once to complete the side.
- Repeat the process until you have finished drawing the polygon. Double click to complete the drawing.
- Click **Append Selected Polygon on the Map to Study Area**. The message, “Study area updated successfully” will appear.

Draw a freehand polygon using the following directions:

- Click on the **Draw freehand polygon tool**.
- Click at the location where you would like the polygon to begin.
- Click and drag the mouse until you have created your polygon. Remove your finger from the mouse button to complete the drawing.
- Click **Append Selected Polygon on the Map to Study Area**. The message, “Study area updated successfully” will appear.

When you have completed this successfully, your screen will look like the following
3.2 **Feature Selection tab**

Selecting a study area is one of the first tasks that is performed when producing a query. There are two options: **Add from map selection, Select from boundaries**. The below steps will help you with the second option: **Select from boundaries**.

The **Feature Selection** tools are used to select a boundary. Boundary types available using the drop down includes **County, City/Town, Village**, and **Indian Reservation**.

The **Feature Selection** tools are shown below.
Using the drop down arrows, select the appropriate boundary, and whether you would like to make a new selection (New), add to a selection (Add), or remove a selection (Remove).

To select features, one of the following tools can be used: the Select by point tool, the Select by polyline tool, the Select by polygon tool, or the Select by rectangle tool.

The Select by point tool can be used using the following steps:
- Click on the Select by point tool.
- Click on the location you would like to select.

The Select by polyline tool can be used using the following steps:
- Click on the Select by polyline tool.
- Click on the location where you would like the line to begin.
- Drag the mouse where you would like the line to end. Click twice to complete the line.

The Select by polygon tool can be used using the following steps.
- Click on the Select by polygon tool.
- Click at the location where you would like the first side to begin.
- Click and drag the mouse where you would like the first side to end. Click once to complete the side.
- Repeat the process until you have finished drawing the polygon. Double click to complete the drawing.

The Select by rectangle tool can be used using the following steps.
- Click on the Select by rectangle tool.
- Click on the map to start the rectangle.
- Drag the mouse to create the appropriate shape. Remove your finger from the mouse button to complete the rectangle.

Once you have completed your selection, the boundaries will appear highlighted in green. Click Append Selected Polygon on the Map to Study Area. The message, “Study area updated successfully” will appear.
Chapter 4
Creating a Simple Query

Introduction
In this lesson, you will learn how to create a simple query in ALIS. A simple query is a request for information from ALIS. A query will produce records which can be used to create maps and run reports.

Learning Objectives
After completing this lesson, you will be able to:
- Create a simple query.
- Add the study area using the most appropriate method.
- Save and schedule the query to be run.
- Print the map
4.1 Enter/remove cases

- On the Load Cases (SQR) tab, in the leftmost box, enter a Case # and click Add.

- The case number will appear in the map and in the viewbox.
- To remove a case, in the leftmost box, enter a Case # and click Remove.

4.2 Create a simple query

- On the Load Cases (SQR) tab, click Simple Query.

- The New Simple Query dialog appears.
• Under **Query Date Range**, select a **Start Date** and an **End Date** using the calendar tool. (Step 1)

4.3  **Add the study area (Step 2)**

The study area can be added in two ways: Add from Map Selection and Select from Boundaries.

**Add from Map Selection**
- Click the button labeled, **Add from Map Selection**.
Create a feature selection using the steps shown in Chapter 3 Using the Draw Tools.
- When complete, click on Append Selected Polygon on the Map to Study Area.
- The message, “Study area updated successfully” appears.

Select from Boundaries
- Click the button labeled, Select from Boundaries.
- Using the listbox labeled Boundary Type, select a Boundary Type.
- The Boundary Names listbox will populate with boundary names corresponding to the boundary type selected.
- Using the listbox labeled Boundary Names, select a Boundary Name.
- When complete, click on Append to Study Area.
- The message, “Study area updated successfully” appears.
- The boundary name you selected will appear under Selected Boundary Names.

When the study area has been selected, click the Next button to move to the next tab (Step 3).

4.4 Save the query

- In the textbox labeled Please Enter New Query Name, enter a name for the query.
  NOTE: Special characters (such as a comma, ampersand, etc) are not allowed in the query name.
- Click the button labeled Save Query.
4.5 Print the map

- On the toolbar located on the left hand side of the screen, click the icon labeled Print Map.

- The Print Map dialog appears.

  - In the text box labeled, Print Map Title, enter a title for the map (Step 1).
  - If desired, choose to Fit into One Page, Rotate Map 90°, and Print Legend (Step 2).
  - When finished, click on Print Map (Step 3).
  - The Print dialog box will appear. Select a printer and click Print.
Introduction
In this lesson, you will learn how to check the status of a query. You will also learn how to load the results of a query into a map so they can be viewed.

Learning Objectives
After completing this lesson, you will be able to:

- Check the status of a scheduled query.
- Load into the map the results of an existing query.
The **Simple Query Results** tab is in the top middle portion of the screen on the tab labeled **Simple Query Results**. Functions in **Simple Query Results** are 1) **Check Status**, 2) **Load Results**.
5.1 Check the status of a scheduled query

Check Status is the first button on the Simple Query Results tab of the toolbar. Click on the Check Status button to open the Check Query Status window.

Click the Check Query Status Now button to get the latest status on the query. This refreshes the information listed in the QUERYSTATUS column.

In the table above, under the QUERYSTATUS column, there are three possible messages: Scheduled, Running, and Success. When the message Success appears, that means the query has run successfully and is ready to be viewed. In the table, navigate to the NUMOFRESULTACCIDENTS column. This column will tell you how many records the query has retrieved.
5.2 Load the results of an existing query

Load Results is the second button on the Simple Query Results tab of the toolbar. Click on the Load Results button to open the Load Results window.

After you have successfully run a query, you can load the results of a query into the map by clicking on the desired query and clicking on the button Load Result Layers of the Selected Query. The records will appear in the map and they will also appear in the viewbox.

A screenshot is shown below.
Chapter 6
Creating Reports

Introduction
In this lesson, you will learn how to create various reports. You will learn about the different reports and what information they provide. You will select data for reports and run reports.

Learning Objectives
After completing this lesson, you will be able to:
- Select cases and remove cases
- Filter cases by attributes (case number, case year, etc)
- Create and manipulate the CSV output file from certain reports
- Create reports
- Create Statistical Reports
6.1 Select cases and remove cases.

There are three ways to select cases from the Simple Query Results tab: Select all cases, Unselect all cases, and Toggle Selected Cases. You can also select cases by clicking on the checkboxes next to the cases in the viewbox. The relevant buttons on the toolbar are shown below.

- **Select all cases**
  - Click the button Select all cases. All of the cases will appear in the viewbox with a checkmark next to the case.

- **Unselect all cases**
  - Click the button Unselect all cases. All of the cases will appear unchecked in the viewbox next to the case.

- **Toggle Selected cases**
  - Click the button Toggle Selected Cases. Any records which had a checkmark next to them in the viewbox now will not have a checkmark next to them, and vice-versa.

There are three ways to remove cases from the map and from the Simple Query Results tab: Remove Selected Cases, Remove Cases Selected on Map, and Remove all cases. The relevant buttons on the toolbar are shown below:
Remove selected cases
- Click the button **Remove Selected Cases**. The cases will disappear from the **Simple Query Results** tab and the map.

Remove cases selected on map
- Using the **Draw** tools, use either the **Click to activate draw polygon tool** or the **Click to activate draw freehand polygon tool**. Draw a polygon around the records which you would like to remove from the map.
- Click the button **Remove Cases Selected on Map**. The cases will disappear from the **Simple Query Results** tab and the map.

Please refer to **Chapter 3, Using the Draw Tools**, for more information.

Remove all cases
- Click the button **Remove All Cases**. The cases will disappear from the **Simple Query Results** tab and the map.

6.2 Filter cases

A simple way to filter cases is to use the drop down boxes in the **Simple Query Results** window. Unlike the remove cases buttons mentioned above, the filter can be turned on and off, so the records will not been deleted when you use the filter. The filter is shown in the screenshot below.
• Using the first drop down box, select the attribute by which you would like to filter the data. There are 36 different options. The second dropdown will populate with values based on the attributes you selected.

• Using the second drop down box, select the value by which you would like to filter the data.

• Click on the Filter cases button.

• You will notice two things – the Filter cases button now has a red “X” surrounding it and the cases in the viewbox are filtered.

6.3 Create and manipulate CSV output files

• There are several reporting functions on the Simple Query Results tab. The buttons are shown in the screenshot below:
Clicking on any of the buttons will create a report in .CSV format, which can be saved and opened in Microsoft Excel. The reports include:

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Icon</th>
<th>Report Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Case Ids</td>
<td><img src="image1.png" alt="Image" /></td>
<td>Report contains two columns: Case Number and Case Year</td>
</tr>
<tr>
<td>Save Event/Location Information</td>
<td><img src="image2.png" alt="Image" /></td>
<td>Report contains 41 columns, including Number of injuries and Number of serious injuries for a given accident</td>
</tr>
<tr>
<td>Save Vehicle Information</td>
<td><img src="image3.png" alt="Image" /></td>
<td>Report contains 21 columns, including age and sex of driver</td>
</tr>
<tr>
<td>Save Contributing Factor</td>
<td><img src="image4.png" alt="Image" /></td>
<td>Report contains five columns: Case number, Case year, Vehicle sequence number, etc</td>
</tr>
</tbody>
</table>

To produce a report:

- Click one of the buttons shown above
  - NOTE: To limit the cases shown in the report, select cases using one of the methods shown in Step 1 of this chapter.
- The **Save As** dialog box will appear. Navigate to a location where you would like to save the report. Choose a file name. Click the **Save** button.
- Open **Microsoft Excel**.
- Navigate to the location where you saved the file.
- The report will appear. Make any changes you would like to make to the report. You may want to change the column names to something more descriptive. A listing of the column names and their descriptions is printed in the **Appendices**.
- Click on the Microsoft Office button ![Image](image5.png) and click **Save As**. In order to save any changes you made to the CSV file, click **Save As**, and save the file as an Excel Workbook.
The **Save As** dialog box will appear. Navigate to a location where you would like to save the file. Choose a **File name**. Under **Save as type**, choose **Excel Workbook**. Click **Save**.

---

**6.4 Create Reports.**

There are two sets of reports that can be created: **Reports** and **Statistical Reports**. These reports can be customized with a title and a label for the date covered. They can also be printed.

- Check some cases in the **Simple Query Results** tab.
  
  NOTE: If you do not check some cases, you will get the error message: “Please Select Some Cases First!”

- Click on the **Reports** button on the **Simple Query Results** window.
A dialog box will appear with two tabs – Reports and Statistical Reports. Stay on the Reports tab.

Under Template, choose either: Accident Contributing Factor, Accident Event, Accident Vehicle or Accident Verbal Description Report.

Under User Entered Description, enter a description. This is optional.

Under Date Covered, click in the box and change MM/DD/YYYY to reflect the date range covered in the report. This is optional.

Click Create. Your browser will open with the desired report.

If you are using Windows Explorer, click File > Print to print the report.

A sample Accident Verbal Description report is shown below:
**Accident Location Information System (ALIS)**

**Accident Verbal Description**

Accidents on Route 9 in Warrensburg

Date in this report covers the period 1/1/2013 to present

Complete Accident data from NYSDMV is only available through 2/28/2014 12:00:00 AM

**County:** Warren  
**Muni:** Warrensburg(T)  
**Ref. Marker:** 9 17102207  
**Street:** US ROUTE 9  
**Date/Time:** 1/26/2013 03:25 AM  
**Persons Killed:** 0  
**Persons Injured:** 0  
**Extent of Injuries:**  
**Police Agency:** NYSP CHESTER TOWN  
**Vehicle:**  
**Veh 1:** CAR, VAN, PICKUP  
**Num. of Containers:** 1  
**Direction of Travel:** SOUTH  
**Pre-Accident Action:** GOING STRAIGHT AHEAD  
**Apparent Factors:** UNSAFE SPEED, PAVEMENT SLIPPERY

**Road Conditions:**  
**Road:** CURVE AND GRADE  
**Light Condition:** DARK, ROAD UNLIGHTED  
**Action of Ped/Bicycle:** NOT APPLICABLE  
**Weather:** CLEAR  
**Traffic Control:** NONE  
**Citation Issued:** NO  
**State of Registration:** NY  
**Citation Issued:** Y  
**Driver's Age:** 24  
**Sex:** F  
**Public Property Damage:** OTHER

**Case #:** 2013-34626470  
**Num. of Veh:** 1
6.5 Create Statistical Reports.

- Check some cases in the Simple Query Results tab.
  NOTE: If you do not check some cases, you will get the error message: “Please Select Some Cases First!”
- Click on the Reports button on the Simple Query Results window.

A dialog box will appear with two tabs – Reports and Statistical Reports. Click on the Statistical Reports tab.

Under the white box labeled Filters, there are three reporting options: Accidents in the View Box, Selected Accidents in the Viewbox, and All Accidents (Step 1).

- **Accidents In The View Box** – produces a report with all accidents listed in the Simple Query Results tab viewbox.
- **Selected Accidents in the View Box** – produces a report with only accidents checked off in the Simple Query Results tab viewbox.
- **All Accidents** – produces a report with all accidents independent of the accidents listed in the Simple Query Results tab viewbox.

Filter by **County, Muni, From Date** and **To Date** (Step 2).
*NOTE: For queries where Accidents in the Viewbox or Selected Accidents in the View Box has been selected in above, make sure the filters selected in Steps 2 are within the study area; otherwise, your statistical report will have no accidents.*

- Under **Group By**, use the dropdown box to create a selection (Step 3). The Group By options changes depending on the filters you have selected above.
- Under **Order By**, use the dropdown box to create a selection (Step 4). The Order By options changes depending on the filters you have selected above.
• Under **User Entered Description**, enter a title for the report (Step 5). This is optional.

• Under **Date Covered**, click in the box and change the text “MM/DD/YYYY” so it reflects the range of dates contained in the report (Step 6). This is optional.

• Click **Create**. Your browser will open with the desired report.

• If you are using Windows Explorer, click **File > Print** to print the report.

A sample **Statistical Report** is shown below.
This is a listing of the columns that appear in the above report and the column descriptions.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TOTAL</td>
<td>Accidents</td>
</tr>
<tr>
<td>AT INT.</td>
<td>Accidents at an intersection</td>
</tr>
<tr>
<td>FTL</td>
<td>Fatal accidents</td>
</tr>
<tr>
<td>INJ</td>
<td>Injury accidents</td>
</tr>
<tr>
<td>PDO</td>
<td>Property Damage Only (PDO) accidents</td>
</tr>
<tr>
<td>N/R</td>
<td>Not reportable accidents</td>
</tr>
<tr>
<td>WET ROAD</td>
<td>Accidents occurring on a wet road</td>
</tr>
<tr>
<td>FIXED OBJ</td>
<td>Accidents involving a fixed object</td>
</tr>
<tr>
<td>PED &amp; BIKE</td>
<td>Accidents involving bikes or pedestrians</td>
</tr>
<tr>
<td>TRUCK</td>
<td>Accidents involving trucks</td>
</tr>
<tr>
<td>DWN/DSK</td>
<td>Accidents occurring at dawn or dusk</td>
</tr>
<tr>
<td>DAY</td>
<td>Accidents occurring during the day</td>
</tr>
<tr>
<td>NIGHT</td>
<td>Accidents occurring during the night time</td>
</tr>
</tbody>
</table>

NOTE: FTL, INJ, and PDO are classifications assigned to an accident by the Department of Motor Vehicles.
The appendix contains a listing of the fields included in the reports and the field descriptions.
Appendices

Below is a listing of the different columns that are contained in many of the reports, and their descriptions.

**Event/Location Information Report**

To access the Event/Location Information Report, click the fifth button from the left in the Simple Query Results dialog box.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OBJECTID</td>
<td></td>
</tr>
<tr>
<td>ISDOTVERIFIED</td>
<td>Is DOT verified</td>
</tr>
<tr>
<td>CASE_NUM</td>
<td>Case number assigned by DMV</td>
</tr>
<tr>
<td>CASE_YEAR</td>
<td>Year of accident</td>
</tr>
<tr>
<td>LASTEDITOR</td>
<td>Last editor</td>
</tr>
<tr>
<td>ACC_DATE</td>
<td>Date of the accident in the format 05-JAN-1991</td>
</tr>
<tr>
<td>ACCD_TME</td>
<td>Time of the accident in military hours/minutes</td>
</tr>
<tr>
<td>COMPX</td>
<td>Computed x coordinate</td>
</tr>
<tr>
<td>COMPY</td>
<td>Computed y coordinate</td>
</tr>
<tr>
<td>ACCD_TYP</td>
<td>Accident type code which describes what a vehicle collided with</td>
</tr>
<tr>
<td>TRAF_CNTL</td>
<td>Traffic control present at the accident location</td>
</tr>
<tr>
<td>COLLISION_TYP</td>
<td>Type of collision encountered when the accident involves multiple vehicles</td>
</tr>
<tr>
<td>WEATHER</td>
<td>Weather condition at the time of the accident.</td>
</tr>
<tr>
<td>LIGHT_COND</td>
<td>Light condition at the time of the accident. Data element only found on the police accident report.</td>
</tr>
<tr>
<td>ROAD_CHAR</td>
<td>Road Character at the location of the accident. Based on the police officers observation/interpretation.</td>
</tr>
<tr>
<td>NUM_OF_VEH</td>
<td>Number of vehicles involved</td>
</tr>
<tr>
<td>DMV_ACCD_CLSF</td>
<td>Classification assigned to the accident by the NYS DMV</td>
</tr>
<tr>
<td>ROAD_SURF_COND</td>
<td>Road surface condition at the time of the accident</td>
</tr>
<tr>
<td>PED_LOC</td>
<td>Code which describes the location of a pedestrian when involved in an accident</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>NCIC</td>
<td>NCIC Number (Court jurisdiction)</td>
</tr>
<tr>
<td>COMP_COUNTY</td>
<td>County</td>
</tr>
<tr>
<td>COMP_MUNI</td>
<td>Municipality</td>
</tr>
<tr>
<td>COMP_MUNI_TYPE</td>
<td>Municipality type (city, town, village)</td>
</tr>
<tr>
<td>COMP_REF_MRKR</td>
<td>Reference Marker</td>
</tr>
<tr>
<td>ROADSYS</td>
<td>Road system</td>
</tr>
<tr>
<td>COMPSEGID</td>
<td></td>
</tr>
<tr>
<td>COMPNODEID</td>
<td></td>
</tr>
<tr>
<td>ATINTERSECTION_IND</td>
<td>Indicates if the accident occurred at an intersection</td>
</tr>
<tr>
<td>NON_HIGHWAY_IND</td>
<td>Indicates if the accident is a non-highway accident</td>
</tr>
<tr>
<td>PARKINGLOT_IND</td>
<td>Indicates if the accident occurred in a parking lot</td>
</tr>
<tr>
<td>ATRAILROAD_IND</td>
<td>At railroad indicator</td>
</tr>
<tr>
<td>FIRSTCODED_DTE</td>
<td>First coded date</td>
</tr>
<tr>
<td>PED_ACTN</td>
<td>Pedestrian action prior to being involved in the accident</td>
</tr>
<tr>
<td>NUM_OF_INJURIES</td>
<td>Number of injuries</td>
</tr>
<tr>
<td>NUM_OF_SERIOUS_INJ</td>
<td>Number of serious injuries (&quot;A&quot;)</td>
</tr>
<tr>
<td>NUM_OF_FATALITIES</td>
<td>Number of fatalities</td>
</tr>
<tr>
<td>DAYOFWEEK</td>
<td>Day of week</td>
</tr>
<tr>
<td>ON_STREET</td>
<td>On street</td>
</tr>
<tr>
<td>CLOSESTCROSSSTREET</td>
<td>Closest Cross Street</td>
</tr>
<tr>
<td>Lat</td>
<td>Latitude</td>
</tr>
<tr>
<td>Lon</td>
<td>Longitude</td>
</tr>
</tbody>
</table>

**Vehicle Information Report**

To access the **Vehicle Information Report**, click the sixth button from the left in the Simple Query Results dialog box.
<table>
<thead>
<tr>
<th>Column Name</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CASE_NUM</td>
<td>Case Number assigned by DMV</td>
</tr>
<tr>
<td>CASE_YEAR</td>
<td>Year of accident</td>
</tr>
<tr>
<td>VEH_SEQ_NUM</td>
<td>Number for each vehicle involved in the accident</td>
</tr>
<tr>
<td>RGST_TYP</td>
<td>Registration type of vehicle involved in the accident assigned by DMV</td>
</tr>
<tr>
<td>BODY_TYP</td>
<td>Body type of vehicle involved in the accident assigned by DMV</td>
</tr>
<tr>
<td>VEH_TYP</td>
<td>Vehicle type is determined by grouping selected registration and body types together. Note: the category truck is intended to include only large trucks and excludes pickups and vans.</td>
</tr>
<tr>
<td>PRE_ACCD_ACTN</td>
<td>Pre accident action describing the motions of a vehicle prior to the occurrence of an accident</td>
</tr>
<tr>
<td>SECOND_EVENT</td>
<td>Second event describes any secondary collisions or events that may happen to a vehicle after the initial first event.</td>
</tr>
<tr>
<td>VEH_DIRN_OF_TRAV</td>
<td>Direction the vehicle was traveling prior to the accident</td>
</tr>
<tr>
<td>HAZ_CARGO_IND</td>
<td>Hazard category indicates whether or not a vehicle was carrying hazardous cargo</td>
</tr>
<tr>
<td>TCK_BUS_CLSF</td>
<td>Truck/Bus classification for the vehicles involved in the accident.</td>
</tr>
<tr>
<td>PBL_PRPT_IND</td>
<td>Public property damage identifies whether the vehicle caused damage to public property.</td>
</tr>
<tr>
<td>COMM_VEH_IND</td>
<td>Indicator if the vehicle meets the truck/bus reporting requirements</td>
</tr>
<tr>
<td>AGE</td>
<td>Age of the driver of the motor vehicle, pedestrian, or bicyclist</td>
</tr>
<tr>
<td>SEX</td>
<td>The sex of the driver, pedestrian, or bicyclist</td>
</tr>
<tr>
<td>OCCUPANT_NUM</td>
<td>Number of persons including the driver in or on the motor vehicle</td>
</tr>
<tr>
<td>RGST_WGT</td>
<td>The registered weight in pounds of the motor vehicle</td>
</tr>
<tr>
<td>CIT_IND</td>
<td>Indicator which tells if a ticket was issued to the driver</td>
</tr>
<tr>
<td>DRVR_LIC_ST</td>
<td>Two digit state abbreviation where the driver is licensed</td>
</tr>
<tr>
<td>VEH_LIC_ST</td>
<td>Two digit state abbreviation where the driver is registered</td>
</tr>
<tr>
<td>TOW_IND</td>
<td>Indicator which tells if the vehicle was towed from the scene of the accident to another location</td>
</tr>
</tbody>
</table>
**Contributing Factor Report**

To access the **Contributing Factor Report**, click the seventh button from the left in the Simple Query Results dialog box.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CASE_NUM</td>
<td>Case Number assigned by DMV</td>
</tr>
<tr>
<td>CASE_YEAR</td>
<td>Year of accident</td>
</tr>
<tr>
<td>VEH_SEQ_NUM</td>
<td>Number for each vehicle involved in the accident</td>
</tr>
<tr>
<td>APRNT_SEQ_NUM</td>
<td>Number associated apparent factor record</td>
</tr>
<tr>
<td>APRNT_FCTR</td>
<td>Apparent factor associated with vehicle</td>
</tr>
</tbody>
</table>

![Simple Query Results dialog box](image)

---

Simple Query and Reporting (SQR) User Manual

Page 44

10/22/2014